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Disclaimer of liability

The contents of this documentation have been carefully checked for consistency with the hardware and
software systems described. Nevertheless, it is impossible to completely rule out inconsistencies, so that we
decline to offer any guarantee of total conformity.

We reserve the right to make technical modifications of the systems.

Copyright

© 2025 imc Test & Measurement GmbH, Germany

This documentation is the intellectual property of imc Test & Measurement GmbH. imc Test & Measurement
GmbH reserves all rights to this documentation. The applicable provisions are stipulated in the "imc Software
License Agreement".
The software described in this document may only be used in accordance with the provisions of the "imc
Software License Agreement".

Open Source Software Licenses

Some components of imc products use software which is licensed under the GNU General Public License (GPL).
Details are available in the About dialog.

A list of the open source software licenses for the imc measurement devices is located on the
imc STUDIO/imc WAVE/imc STUDIO Monitor installation medium in the folder "Products\imc DEVICES\OSS" or
"Products\imc DEVICEcore\OSS" or "Products\imc STUDIO\OSS". If you wish to receive a copy of the GPL sources
used, please contact our tech support.
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Notes regarding this document

This document is an excerpt from the manual of imc STUDIO Monitor.

The manual for imc STUDIO Monitor is available both as an e-book and in PDF format. In the menu bar, click on
the symbol  to open the help.

The program "imc Help and Documentation" provides you with access to all formats and other documents such
as the device documentation or the technical data sheet.

What is the best way to read the imc STUDIO Monitor documents?

Getting Started

Before installing the software, start by reading the document "Getting Started". This contains important tips for
achieving problem-free installation, for updating the software, as well as for operation and integration of devices
in measurement setups.

All information presented in the document "Getting Started" is also presented in the imc STUDIO Monitor
manual.

Manual - complete documentation

The manual serves as reference material. This document describes how to operate the software and how to
configure parameters for the devices. In some case, individual device groups have special functions. The
documentation for these usually appear exclusively in the device manuals.

Training programs for introduction to the systems, and advanced workshops

We recommend that before you begin working with imc STUDIO Monitor you participate in an extensive training
session. Such training will enable you to get started working efficiently much faster. Additionally, you will obtain
valuable tips and information on how to use the software more effectively. More information is available on our
homepage under "Service & Training" > "imc ACADEMY".

Special notes

Warning

Warnings contain information that must be
observed to protect the user from harm or to
prevent damage to property.

 

Note

Notes denote useful additional information on a
particular topic.

Reference

A reference in this document is a reference in
the text to another text passage.
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Before you start Chapter   1

1  General introduction

1.1  Before you start

Dear user.

1. The software you have obtained, as well as the associated manual are directed toward competent and
instructed users. If you notice any discrepancies, we request that you contact our tech support .

2. Updates during software development can cause portions of the manual to become outdated. If you
notice any discrepancies, we request that you contact our tech support.

3. Please contact our tech support if you find descriptions in the manual which you believe could be
misunderstood and thereby lead to personal injury.

4. Read the enclosed license agreement . By using the software, you agree to the terms and conditions of
the license agreement.

Note Notes on the descriptions and the screenshots

· The help may also contain parts shared imc software components. These parts may differ from the rest
of the help in terms of style and structure. All help files are equipped with a full text search functionality
and have an index.

· The screen shots appearing in this documentation were created with a variety of Windows versions and
their appearance may thus differ from that of your installed program.

· imc STUDIO works with user groups and access rights. The user group has wide-reaching influence on the
visibility and/or operability of menus, icons, etc. Note that in all imc STUDIO documents the administrator
roll is assumed to be filled. All descriptions are therefore related to the full utilization of the user
interface.

· The following descriptions and screenshots always pertain to the view with the full scope of functions
(Complete). Many of these functions are also found in the minimized view at another location.

1.2  Tech support
If you have problems or questions, please contact our tech support:

Phone: (Germany): +49 30 467090-26

E-Mail: hotline@imc-tm.de

Internet: https://www.imc-tm.com/service-training/

Tip for ensuring quick processing of your questions:

If you contact us you would help us, if you know the serial number of your devices and the version info of the
software. This documentation should also be on hand.

· The device's serial number appears on the nameplate.

· The program version designation is available in the About-Dialog (click on the symbol  in the menu bar).

6

8
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Product Improvement and change requests

Please help us to improve our documentation and products:

· Have you found any errors in the software, or would you suggest any changes?

· Would any change to the mechanical structure improve the operation of the device?

· Are there any terms or explanations in the manual or the technical data which are confusing?

· What amendments or enhancements would you suggest?

Our tech support  will be happy to receive your feedback.

1.3  Service and maintenance
Our service team is at your disposal for service and maintenance inquiries:

Phone: (Germany): +49 30 629396-333 (Mon.-Fri.: 9.00 - 12.00 and 13.00 - 17.00)

E-Mail: service@imc-tm.de

Internet: https://www.imc-tm.com/service

Service and maintenance activities include, for example calibration and adjustment, service check, repairs.

1.4  Legal notices

Quality Management

imc Test & Measurement GmbH holds DIN EN ISO 9001 certification since May
1995 and DIN EN ISO 14001 certification since November 2023. You can download
the CE Certification, current certificates and information about the imc quality
system on our website:
https://www.imc-tm.com/quality-assurance/.

imc Warranty

Subject to the general terms and conditions of imc Test & Measurement GmbH.

Liability restrictions

All specifications and notes in this document are subject to applicable standards and regulations, and reflect the
state of the art well as accumulated years of knowledge and experience. The contents of this document have
been carefully checked for consistency with the hardware and the software systems described. Nevertheless, it
is impossible to completely rule out inconsistencies, so that we decline to offer any guarantee  of total
conformity. We reserve the right to make technical modifications of the systems.

The manufacturer declines any liability for damage arising from:

· failure to comply with the provided documentation,

· inappropriate use of the equipment.

6
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1.5  imc Software License Agreement
imc Test & Measurement GmbH
Voltastr. 5
13355 Berlin, Germany 
Trade register: Berlin-Charlottenburg HRB 28778
Managing directors: Michael John Flaherty, Frank Mayer

imc Test & Measurement GmbH
Terms and Conditions

Governing the Use of imc Test & Measurement GmbH Software
As of: January 18th, 2024

§ 1 Objects of the Agreement

(1) In addition to the "General Terms and Conditions Governing imc Test & Measurement GmbH Deliveries and Services to
Customers", these terms and conditions apply to all contracts concluded with  imc Test & Measurement GmbH
(hereinafter referred to as "imc") which involve the transfer of rights of use to any software developed by imc (standard
software, software created or adjusted specifically for the Customer, which is recorded on the machine-decodable data
carriers such as data files, databases and database material, updates, upgrades, releases, etc., including corresponding
documentation, information and materials, hereinafter referred to as "Software").

(2) The Software is provided to the Customer as an executable object program on machine-decodable data carriers specified
in the "Objects of the Agreement". The Software's product documentation is also supplied to the Customer either in print
or on a machine-decodable data carrier. Unless otherwise expressly agreed in writing, the Customer is not issued the
source code of the Software.

§ 2 Rights of Use, Scope

With regard to any transfer of rights of use to Software created by imc, the following provisions apply:

(1) Basic provisions

 a) The Customer is granted a non-exclusive and – subject to the terms and conditions governing the use of Software by
third parties, resale and leasing – non-transferrable right of use to the Software for its own purposes. "Use" signifies
running the programs and editing the data records.

 b) Until each due fee is paid in full, the Customer is entitled to use the Software solely on a revocable basis. If the
Customer is in default with regard to the payment of fees, imc is entitled to revoke the use of the respective services
for the duration of the default. The Customer is granted the permanent right to use copyright protected services, in
particular the Software, only upon full payment of the agreed fee.

 c) The Customer agrees to undertake appropriate precautionary measures to prevent unauthorized access by third
parties to the Software. The original data carriers and the data carries used to make copies as per the agreement, as
well as the documentation, are to be stored in a secure location. Employees are to be notified that the production of
copies beyond the scope of the agreement is not permitted.

 d) If the right of use is revoked or expires due to another reason, the Customer is obligated to return to imc the
Software, the copies made by the Customer and the documentation. Provided that a physical return of the Software
and the copies is not possible due to technical reasons, the Customer is obligated to delete such and confirm deletion
to imc in writing.

(2) Reproduction

 a) The Customer is entitled to make copies of the Software only if copies are necessary to use the Software in
accordance with the contract. The following are considered cases in which reproduction is necessary: installation of
the Software from the original data carrier onto the hard disk drive of the hardware used, as well as loading the
Software into the computer memory. 

 b) The Customer is entitled to create a backup copy if such is necessary to safeguard future use. Copies may only be
made for other purposes after prior written consent has been issued by imc. 

 c) The Customer is not allowed to make any reproductions other than those expressly permitted under the provisions of
this agreement.
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(3) Use of the Software by Third Parties, Resale and Leasing

 a) The Software may be used for the purposes stipulated in this contract, in particular for the Customer's business
operations. Access to the Software may also be provided to parties which rely on using the Software as instructed by
the Customer. In particular, the Customer is entitled to operate the Software or allow the Software to be operated on
data processing devices, which are located on the premises of and are directly owned by a third party company
(outsourcing). The prohibition against multiple use remains unaffected. 

 b) The Customer may permanently sell or give the Software to third parties provided that the Customer is granted
permanent use of the Software. In the context of its period of use, the Customer may temporarily transfer the
Software to third parties for a fee or free of charge. The prohibition against multiple use remains unaffected. The
Customer is expressly notified that transfer to third parties is not permitted and use by third parties is technically not
possible if an individual license must be acquired or an individual activation is required for third party usage, such as in
the case of runtime licenses.

 c) With regard to the valid use of Software by a third party, the Customer is obliged to ensure that the third party
acknowledges the provisions of this agreement governing the rights of use as binding for such third party. The
Customer may not transfer Software and documentation to third parties if there are grounds to suspect that the third
party may infringe upon the provisions of this agreement governing the rights of use, in particular with regard to the
unauthorized production of copies. 

 d) Subject to the provisions stipulated in § 4 Paragraphs 1 and 2 or a deviating express agreement in writing, the
Customer may not use the Software while the Software is being used by a third party (prohibition against multiple
use); in the event that the Software is transferred to the third party, the customer is obliged to surrender to imc all
Software copies including, if applicable, all existing backup copies, or to destroy copies not surrendered.

(4) Decompilation

The reverse translation of the provided program code into other code forms (decompilation), disassembling and other
forms of reverse engineering of the various production phases of the Software is not permitted. If interface information is
required to achieve the interoperability of a separately created computer program, such may be requested from imc, or a
third party to be named by imc, for a minor fee. Section 69 e of the German Copyright Act ("UrhG") remains unaffected
by this provision.

(5) Changes by imc

If imc conducts adjustments, changes or enhances the Software on behalf and on account of the Customer, the Customer
thus acquires the corresponding rights of use to the changes or enhancements of the Software to which he is entitled
according to the stipulations of this agreement.

(6) Exceptional Usage Requests by the Customer

If the Customer requests to use the Software according to terms which deviate from the requirements stipulated in
Paragraphs 2 through 5, this exceptional use of the Software must be agreed in writing by imc. In such an instance, the
Customer agrees to provide imc with information about the desired scope of use, the pertinent field of application, etc. If
imc subsequently grants a license covering the Customer's special intended use, the parties agree that a new license fee is
owed by the Customer, which is independent of payments made by the Customer for the previously existing license.

§ 3 Copyright, Protection of the Software

(1) The intellectual property, in particular the copyright as well as all industrial property rights and trade secrets, are retained
by imc and are not transferred to the Customer. The Customer's ownership of the machine-decodable data carries and
data processing units remains unaffected.

(2) Copyright notices, serial numbers as well as designations and reservations of rights which serve as program identification
or a protective right may not be removed or changed. The Customer is obliged to transfer the existing protective right
notices to all copies. In particular, backup copies of the Software must be expressly designated as such.

§ 4 License Types, Multiple Use

(1) In the case of a Single-User License, the Software may be activated and run on only one data processing unit. "Activation"
refers to the process of transferring the license to the data processing unit.

If the technical specifications for the Software permit a second activation, then the Customer may additionally activate
the Software on a second data processing unit. However, the Software may only run on one data processing unit at any
one time, not on both simultaneously.
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(2) With a Network License, the Software may be run on as many data processing units as the amount of licenses obtained.
In this case a central data processing unit acts as the license server for which the activation process is performed.

If the technical specifications for the Software permit a second activation, then the Customer may additionally activate
and run the Software on as many data processing units as the amount of licenses obtained. However, these additional
data processing units must be used by the same users who operate the Software via the license server.

(3) Subject to the provisions in Paragraphs 1 and 2 or a deviating express agreement in writing regarding network use,
multiple use of the Software is not permitted.

(4) If the data processing unit is changed, the Customer is obliged to delete the Software from the hard disk drive of the
previously used hardware.

§ 5 Software-Subscription

If the Software used is a software-subscription, the following additional restrictions apply:

(1) The right of use is valid for a limited time period. The start and end of the time period are specified. After the end of the
time period, the right of use is expired.

(2) If the Customer wishes to continue using the Software after elapse of the specified time period, the subscription must be
renewed.

§ 6 Trial Version

If the Software used is a free trial version, then the following additional limitations apply:

(1)  The trial version only entitles the user to test the Software. In particular, commercially productive utilization is not
permitted.

(2)  The rights of use granted expire after the elapse of a period stated in the product description.

§ 7 License Key

(1) Upon delivery of the Software the Customer receives a License Key. Using this License Key, the Customer is able to
activate the Software purchased. By means of this License Key the Customer can also view his license status and order
updates and upgrades.

(2) The License Key is to be protected against access by third parties in order to prevent misuse. If, however, a third party
gains unlawful access to the Key, the Customer is obliged to notify imc immediately via telephone, as well as in writing, so
that the previous License Key may be suspended and a new one issued.

§ 8 Conclusion

(1) The law of the Federal Republic of Germany shall apply under exclusion of private international law. The provisions of the
UN Convention on Contracts for the International Sale of Goods (CISG) do not apply.

(2) The place of performance for all obligations arising from this agreement is imc's registered seat. Insofar as the Customer
is a merchant as defined by the German Commercial Code (HGB), a legal entity under public law, or a special asset under
public law, the exclusive place of jurisdiction for all disputes directly or indirectly arising from the contractual relationship
is agreed as imc's registered seat. The same applies to persons who have no general place of jurisdiction in Germany, as
well as to persons who have moved their place of residence or usual whereabouts abroad since conclusion of the
contract, or whose place of residence or usual whereabouts is unknown at the time the action is filed. In addition, imc is
entitled to file suit at the statutory venue.

(3) Oral side-agreements are not valid. Deviating or supplementary conditions as well as modifications of this contract,
including this written requirement clause, are only valid if agreed in writing and expressly marked as a modification or
supplement.

(4) If certain provisions of this contract are inoperative or unfeasible, this does not prejudice other provisions of the contract.
The contracting parties agree to contractually substitute an operable provision which approximates the commercial
intention of the contract as closely as possible for any inoperable one.
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 Chapter   2

2  Overview
This document describes the first steps in operating imc STUDIO Monitor and the installation of additional imc
products. This document uses textual references to the product documentation.

imc STUDIO Monitor is an application which is constructed upon imc STUDIO. Many components of imc STUDIO
are used. For this reason, some of the descriptions may make reference to imc STUDIO.

Which components are available depends on the product installation (order).

Chapter overview

Synopsis Section

Startup operations for imc STUDIO Monitor - installation and
product configuration prior to first use

· System requirements

· Installation / Uninstall

· Product Configuration / Licensing

· The first start

· Device connection / Network / Firewall

The first run - What steps are necessary in order to obtain
measured data?

· Monitor - First steps

Data storage: How are data stored and loaded
· Experiments, Projects and the Database

· Ribbon "Project": Open / Save experiments

Navigation through the entire software
· Navigation Pane

The software user's interface is flexible. Saving and restoring
of views

· Saving / Loading views

Tech support

If you have any open questions about our products, please contact our tech support.

Questions or problems? Contact our Tech support .
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38

41

48

50
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3  Setting Up - Software

3.1  System requirements

Supported operating systems

Windows 10*/11* (64 bit)

*released in conformance with the version of Windows 10/11
applicable at build date of imc software

Minimum requirements for the PC

4-core CPU 2 GHz 1

8 GB RAM (recommended: 16 GB RAM) 1

10 GB free hard disk space (recommended: SSD) 2

Display resolution: 1366 x 768 (recommended: 1920x1080)

1 Requirements and recommended minimum configurations for the applied PC will rise with increasing number of connected devices and
the resulting overall system data rate. Another crucial factor will be the extend of used live analysis and visualization functions on the
PC (in particular Data Processing, imc Inline FAMOS and active curve windows).
A smooth operation will also heavily rely on sufficient RAM memory resources on the PC: It must ensure to satisfy all vital functions
without any outsourcing to slow external swap file (HDD/SSD) in order to guarantee sustainable performance.

2 The hard drive memory requirement increases if measured data are saved to the PC.

Other operating system components

The following components are installed with the imc STUDIO Monitor setup if they are not already present:

Component Version Folder in "System" directory

Microsoft .NET Framework 4.8 DotNetFx4.8

Microsoft VC 2015-2022 14.38.33135 Microsoft Visual C++ Redistributable\2022

Microsoft VC 2010 10.0.40219.1 Microsoft Visual C++ Redistributable\2010

Microsoft Build Tools 2015 14.0.23107.10 MSBuildTools2015

Supported measurement devices

Which devices you can use in imc STUDIO Monitor is described in the documentation on the "Setup" > "Device
Overview", as well as in the "Technical Data Sheet".
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3.2  Installation - Preparation

Software requires a license

This means that the program may only be started upon obtaining a license (see Product Configuration /
Licensing ).

Administrator rights required

For the purposes of installation and uninstallation, a user account with administrator privileges for the PC is
required.

If you are logged on to the PC without administrator rights, log yourself out and log back on with an
administration-level user account. If you don't possess the appropriate account type, you will need the support
of your system administrator or IT department.

See also Notes on Windows User Account Control .

Restarting the computer in the process of installation

During the installation process, the installation program will prompt you to restart the PC.

Note Restarting

After the restart, login to the same user account with which you had previously begun the installation.

Coexisting applications: imc STUDIO, imc STUDIO Monitor, imc WAVE, ...

Some imc programs are installed as an independent and specially adapted instance of imc STUDIO. They are
based on imc STUDIO.

Unless otherwise stated, these programs are installed and used in parallel. As long as these instances are based
on the same version of imc STUDIO (e.g. 2022 R1), they are all subordinated to the same program installation,
which means they share resources.

For this reason, installation of the instances in this case must be performed in one
single shared Setup procedure. Any attempt to perform installation in succession or
subsequently will cause the already existing instances to be deleted.

This applies particularly to the joint and parallel installation of imc STUDIO Monitor,
imc WAVE and imc STUDIO, which must be performed in a single step.

Do not install
imc STUDIO, imc WAVE
and imc STUDIO Monitor
in succession, but always
at the same time.

Update or parallel installation

The Setup utility checks whether any version of imc STUDIO (imc STUDIO Monitor) is currently installed on the
computer. If so, it can be uninstalled by means of the Setup. An associated confirmation prompt is posted in that
case. All user data such as the database remain intact.

The two versions can be installed in parallel provided that they have differing version numbers (e.g. 5.2 and
2023). The new version can be installed in the same folder (default case: "C:\Program Files\imc"). In this folder, a
new subfolder with the new version number is created for imc STUDIO.

In both cases, you are able to adopt a variety of settings from the old versions. These include the project
settings and views. By contrast, other settings such as the product configuration and the database path need to
be set up from the beginning.

26

16
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Adopting the settings with the help of the existing database (recommended)

When an existing database continues in use, any settings which can be retained will be retained. For a parallel
installation, two data bases are needed. Create a copy so that the old imc STUDIO Monitor version can continue
to work with the existing database. A confirmation prompt about making a copy is posted.
See: Update with the help of the existing database .

Adopting the settings without using the existing database

Some settings, e.g the views, can also be retained without the database. To do this, save and import the
appropriate settings.
See: Update without using the existing database .

The subsequent procedure - an overview

Follow the installation program instructions (see: "Installation step by step ").

· The installation process first checks whether the required system software is installed. If ones is missing, it
will be installed automatically.

· After restarting the system, the selected  products are installed.

· After the installation is concluded, it is possible to start imc LICENSE Manager directly to activate your
license.

· Once the license has been activated, imc STUDIO Monitor is ready for use.

Uninstalling

Un-installation is performed via the menu item "Windows-Settings" > "Apps & features".

Reference See also

· Recommended Virus Scanner Settings

· Changing Languages and Installing Additional Languages

15
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3.2.1  Update with the help of the existing database
When an existing database continues in use, any settings which can be retained will be retained. This includes
Views, any Setup-columns created by the user, the user administration and all experiments.

If you wish to run multiple versions of imc STUDIO Monitor or maybe restore an older version at a later time,
create a copy of the database.

Note The database

It is impossible to use the imc STUDIO Monitor database by both versions in parallel.

· If the same path is selected in the new imc STUDIO Monitor version, the database is used automatically.
When loading old experiments, a note is posted in the logbook that the experiments belong to an older
version. Once saved, they can no longer be loaded with the old version.

· If the database structure has been altered, you will be notified of this. A dialog for performing conversion
appears. This dialog can be used to convert the database and, if desired, copy it first. After the
conversion, the entire database can no longer be used with the old version.

Note Using new views

· Be aware that the new version provides new functions, such as new or enhanced Setup pages and new
menu items.

· Use of the new Views is recommended, in order for these new functions to be accessible! Please look
under "What's new" whether there have been any changes in this regard.

· User-made columns such as meta data columns are not automatically inserted into the pages. The
configurations of these columns, however, is adopted from the old View. You can re-insert these columns
at the desired position (by means of the Column Chooser).

· Multiple views are provided. Select a view and add whatever Setup pages are required or saved, and save
the view under a new name.

· How to save Views is explained in the section "Views ".

3.2.2  Update without using the existing database
In imc STUDIO, various settings were saved with the respective project and apply to
all the experiments it contains. Among other things, these include the view settings:
user-defined views, column configurations (e.g. metacolumns).

In order to retain these settings in the new version after having performed the
update without using the existing database, export of the settings are necessary.

Please first check which
settings you will need.

· If you wish to reuse all of the project's settings, export the project settings (by means of the Projects-
dialog: Menu ribbon: "Project" > "Manage Project").

· If you wish to reuse only the viewing settings, export the views .
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3.2.3  Notes and troubleshooting

Notes on Windows User Account Control

Do not change the user account

Example of  a password request.
Select "No".

With Windows, installation can be started without
administrator rights. In this case, the operating
system requires selection of a user account and
associated password, as shown in the example.

Do NOT continue with the installation
in this way, otherwise it will be
incorrect. Select "No".

Confirm the prompt by the user account control

Select "Yes", to start the installation.

When you are logged in to a user account possessing
administrator rights, you may receive a prompt by the
Windows User Account Control (UAC) to allow
changes. Select "Yes".
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Notes on the security software

Some virus scanners prevent correct installation of imc programs. We are currently aware of this affecting
products from the companies McAfee and ESET. In principle, almost any virus scanner can have settings
possibilities which prohibit necessary functions during installation.

For installation purposes, certain steps are necessary, such as:

· registration of programs for Autorun

· registration of programs as a service

· running of scripts from the TEMP-folder

· ...

The error profile may include various messages during installation. Or installed programs failing to launch.

In such cases, please contact your administrator to find out whether certain rules can be suspended for the
duration of the installation. For any further questions, please contact our tech support .

Reference See also

Recommended Virus Scanner Settings

3.3  Installation - Step by step
Actual texts appearing in the user interface may differ from those shown in the screen shots, depending on the
product configuration (path/version name).

Note

The following installation descriptions deal with several products and components. Not everything which
you can activate can actually be used in imc STUDIO Monitor. For an exact listing of all of imc STUDIO
Monitor's functions, see the Technical Specs sheet.

If you activate components which are not available in imc STUDIO Monitor, there won't be any negative
effects on your program. They may even have some purpose if you use multiple products in parallel.

Download and Installation

The most up-to-date version can be downloaded from the imc website under "Downloads" > "imc STUDIO". Both
a complete and a reduced installation package are offered. The reduced installation package is sufficient if you
have only purchased imc STUDIO Monitor. Which products are included is indicated next to the Download
button.

Start the download first, and next the file (e.g. "Installer_imc_STUDIO_2024_R2.exe").

The Installer unpacks the installation files. Subsequently, it independently starts the actual installation. Select an
appropriate folder into which to unpack the files. The system's default suggestion is the Desktop.

Hinweis Installation files

The unpacked files can be deleted or saved once installation is completed. You can also use the unpacked
files for installation at a later time. You do not necessarily need the Installations-exe file. 

6
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Installation language settings

Selecting the language during installation

After starting installation, a window appears in which
to select the installation language.

Performing installation

Installation setup welcome page

The installation setup then starts in the language
selected.

Before starting installation

On the installation setup's next page, you are offered
the following choices:

· open the "Readme"-file,

· open the "Getting Started"-document,

· separate installation of imc LICENSE Manager and

· display of the installation medium contents.

License agreement

You must accept the license agreement to continue
the installation.
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Entering the installation path

The next step is to select the installation folder.
Under this folder, a separate subfolder will be created
for each imc product (e.g. imc STUDIO 2024). It is
recommended to end the associated pathname with
"\imc".
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3.3.1  Select the products / Installation type

Now you can select which components should be installed. There are three types
available:

· "Full functionality for 30-day demo" : hereafter called "Demo"

· "Typical functionality incl. imc STUDIO Professional" : hereafter called "Typical"

· "User-def ined "

For the "Demo" and "Typical" installation types the installation settings are already
configured. If you need further settings choose the "user-def ined " installation
type.

"User-def ined" gives you
the ability to affect all
installation settings.

Installation type Beschreibung

Demo Use the installation type "Demo" in order to test the full scope of imc STUDIO and/or
imc WAVE for 30 days. No other products which require a password will be installed.

imc STUDIO Monitor is not installed.

Typical Use the installation type "Typical" in order to install the Professional edition of imc STUDIO
including all necessary components. No other products which require a password will be
installed.

imc WAVE and imc STUDIO Monitor are not installed.

User-defined Use the installation type "User-defined" if you wish to configure the individual products.
With this type, it is possible to install password-protected components. Further, you can
install and configure additional imc products such as imc FAMOS.

Note that some components can require a separate license.

Note

In order to install imc STUDIO Monitor, you must choose the installation type: "User-def ined " or
"Demo"!

Note imc STUDIO Monitor reconfigure afterwards

Regardless of which variant of the installation is selected, when imc STUDIO Monitor is installed, all
components are included. This way, after successful installation it is possible to adapt the imc STUDIO
Monitor configuration at any time by means of the "product conf iguration ".
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Products
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Description

 ● : included ○ : optional

imc LICENSE Manager ● ● ● Managing the licensing (internal functions, does not appear in the list)

imc Shared Components
● ● ●

Proving common components of the imc products, such as the curve
window (internal functions, does not appear in the list)

Required system components ● ● ● System components require using of imc products.

imc SENSORS (1)

  ○
imc SENSORS is a database application for administering and editing sensor
information. Applicable with devices of the firmware group A
(imc DEVICES).

imc STUDIO Developer (Demo) (2) ●  ○ imc STUDIO is modular software platform handling all aspects of modern
measurement technology from simple data acquisition to sophisticated
test configurations.

imc STUDIO Professional (3)  ● ○

imc STUDIO any edition (3)   ○

imc STUDIO Monitor (3)

  ○

imc STUDIO Monitor makes it possible to connect with one or more
measurement devices, particularly for the purpose of monitoring the
instantaneous readings. Data can be viewed and edited live on multiple
workstations. It is based on imc STUDIO and is installed as a separate
instance of imc STUDIO.

imc WAVE (Demo) (2)
●  ○

imc WAVE is a software package for NVH (Noise Vibration and Harshness)
analysis. It is based on imc STUDIO and is installed as a separate instance of
imc STUDIO. It can be equipped with multiple, separately licensed
analyzers.

imc WAVE (3)
  ○

Firmware and driver package imc DEVICES
● ● ○

Package of device drivers and firmware required by imc STUDIO and
imc WAVE for devices of the firmware group A (imc DEVICES - e.g.
CRONOS family, C-SERIES, SPARTAN, BUSDAQ).

Firmware and driver package
imc DEVICEcore ● ● ○

Package of device drivers and firmware required by imc STUDIO and
imc WAVE for devices of the firmware group B (imc DEVICEcore - e.g.
ARGUSf it, EOS).

imc FAMOS Enterprise (Demo) (2) ●  ○
imc FAMOS is a program for analyzing, evaluating and documenting
measurement results.

imc FAMOS Reader (3) ● ● ○

imc FAMOS any edition (3)   ○

imc Format Converter ● ● ○ Converts imc measurement data to other formats such as EXCEL and ASCII.

imc Documentation
● ● ○

Installs the documentation on the selected products. If the checkmark is
removed, it is not possible to open the documentation via the software.

1: imc SENSORS requires a password for installation.

2: The associated Demo license must be activated after concluding installation by means of imc LICENSE Manager, otherwise it is not
possible to start the product. Once the demo trial period has elapsed, use the product configuration  to covert the product to the
license you have purchased.

3: The associated license must be activated after concluding installation by means of imc LICENSE Manager, otherwise it is not possible to
start the product.

When you select "Demo" or "Typical", the start of the installation follows immediately (see: "Starting the
installation "). By contrast, if you select "User-def ined", the installation is first configured .

26
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3.3.2  User-defined
The installation variant can be configured in detail. Based on your selection of components desired, different
installation steps are displayed.

Selecting components

Selecting User-def ined installation
 

Once you have selected the installation type "User-
def ined", it is possible to select/de-select the desired
products in the box at the bottom.

Activate imc STUDIO Monitor here!

imc STUDIO and imc WAVE, as well as imc SENSORS
are not required for the purpose of operating
imc STUDIO Monitor.

Required system components

Required system components (example)

In the next step, the system components which the
products selected require are displayed, along with a
note about which are already installed on your
system. It is also possible to re-install any already
installed components. Which components are
missing/present depends on the system and it update
status, so that the illustrations are intended as an
example only.

Configuring imc Shared Components

Conf iguring imc Shared Components

In this installation step, it is possible to install
password-protected components of
imc Shared Components.

Option/Component Description

COM Products The imc COM programming interface is a system integration tool 

Class Counting Kit Function library for imc COM products

Spectral Kit Function library for imc COM products
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Password for imc SENSORS

Password prompt for imc SENSORS

If you have selected imc SENSORS, you are prompted
to enter the password prior to installation. But if you
do not wish to install imc SENSORS, de-select it here.

Configuring imc STUDIO

Conf iguring imc STUDIO

It is possible to make settings for your licensed
product edition here. In consequence, later product
configuration  can be omitted.

Option/Component Description

Licensed edition Information on the editions is provided in the "Technical data sheet" for imc STUDIO.

Install additional languages With this option, imc STUDIO Monitor is installed in all available languages. (This will
substantially prolong the installation procedure).

Please be aware that some functions may require the other languages. For instance,
foreign-language parameter sets can only be imported if the associated language is
installed. 

If this option is deactivated, English language is installed plus the language of the operating
system, if available. If needed, all other available languages can be installed at a later time
(see the section "Installing additional languages ").

Create a shortcut on the
desktop

Program starting links can be created on the Desktop.

Explorer extension for data
in the device

Access to the device hard drive via the Windows-Explorer.

for devices of the firmware group A (imc DEVICES)

Service Service support. Install this component only if requested by our tech support.

for devices of the firmware group A (imc DEVICES) and group B (imc DEVICEcore)

26

34



© 2025 imc Test & Measurement GmbH imc STUDIO Monitor 2025 - Getting Started, Doc. Rev.: 8.1 - 2025-03-11
Page   24

Installation - Step by step Chapter   3

Configuring imc FAMOS

Conf iguration of  the imc FAMOS installation

In this step, you configure the imc FAMOS installation.
Select the editions you wish to install. Note that all
editions except the Reader-edition require a license.

Follow the Assistant's instructions and select your
preferred language for the help files and example files
like projects, sequences and dialogs. Select any
optional components which you wish to install along
with imc FAMOS. Additionally, a folder for sample
files is needed.

Reference imc FAMOS editions

More detailed information on the imc FAMOS editions is provided in the imc FAMOS manual.

Once all products have been configured, the installation can start.
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3.3.3  Starting the installation

Concluding the installation setup and starting installation

Before the installation, a system reboot is performed.
For this reason, first close any running programs
before continuing!

Confirm the reboot by means of the checkbox and
then continue (button: "Install"). Initially, the required
system components are installed. Subsequently, the
PC reboots automatically.

Warning Windows user account

After restarting, be certain to log in with the same user account with which you started the installation
process. Using a different user account can cause failure of correct installation of the components.

List of  components to install, following restart
(example)

After logging in, the actual installation of the products
begins. You are presented with a list of which
components are to be installed, which you can
confirm by clicking on "OK".

The figure shows an example; the actual dialog may
appear differently depending on your respective
previous selections.

Next, installation of the individual imc products begins.

Note Disabling the system start

While installation is running, the operating system is disabled from starting again, meaning that no other
programs can be started.

Concluding installation

When installation is finished, the following message is
posted.

Next, you can start imc LICENSE Manager in order to
activate your license. It is also possible to start the
imc LICENSE Manager later via the Start menu.
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3.4  Product configuration / Licensing

Licensing (imc LICENSE Manager)

The software licenses are managed with "imc LICENSE Manager". After concluding installation, you can start
imc LICENSE Manager directly in order to configure your license (e.g. by means of the Windows Start menu:
group "imc" > "imc LICENSE Manager"). If imc STUDIO Monitor is started without an appropriate license having
been configured, the product configuration program opens, from where it is also possible to start
imc LICENSE Manager.

Follow the instructions of the imc LICENSE Manager. imc LICENSE Manager offers a separate documentation.
Start imc LICENSE Manager and click on "Help".

Changing the product configuration

imc STUDIO Monitor is a preconfigured product. You can change the product configuration in order to adapt it to
the license purchased. For instance, if you have purchased optional components. To do this, start imc STUDIO
Monitor and click in the menu bar (top right) on the symbol . The product configuration assistant now opens.
You can change the configuration to correspond to the licenses you have purchased. Follow the instructions and
close the assistant.

After completing the configuration, you must close and restart imc STUDIO Monitor to apply the new settings.

3.5  Start
Start the software by means of the associated desktop icon or via the Start menu.

Further, as part of installation an icon is set up on your desktop - depending on your choice during
installation .

If no icon was set up, then open the Windows Start menu. There you find the group "imc" and in it a
link to start the product.

If product configuration / licensing  is missing, the Product configuration starts automatic.

Splash screen

Next, a splash screen appears, indicating that software components are being
loaded. Depending on the installation and the PC capacity, this could take some
time.

Loading the software
components after start

17
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Homepage - Start page

By default the Homepage is shown when the software is started. The Homepage shows certain functions,
depending on the particular product, as buttons. Click on the corresponding buttons, to select your desired
functions. After the first installation, the "Homepage" may appear as shown in the example below:

Start page (example)

imc STUDIO starts with a simplified view

Along with installation of imc STUDIO Monitor, a number of Views are provided. Views in this sense are defined
designs for the user interface's appearance.

imc STUDIO Monitor offers a wide variety of possibilities and functions, but the entire scope of these is not
always needed for a single simple measurement.

Note imc STUDIO Monitor starts with a simplified view

In order to make it easier to get familiar with the software, the program starts with a simplified view with
limited choices: "Standard". All important functions for measurement and visualization of measured data
are available. The menu ribbon is structured in such a way that proceeding from left to right accesses all of
the Main windows .

Changing from the simplified view to View: Complete

You can switch to a different view at any time, in order to obtain access to all of the existing functions. To do
this, go first to the menu item "Extra" and in the drop-down list of views, select: "Complete".

Note Notes on the descriptions and the screenshots

The following descriptions and screenshots always pertain to the view with the full scope of functions.
Many of these functions are also found in the minimized view at another location.
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3.5.1  Device Connection / Network / Firewall

To use an imc measurement device, imc STUDIO Monitor must set up a connection via a network. Details on the
network settings are presented in the manual for the device software in the chapter "Setting Up - Connect the
device". At this point in the instructions, it is assumed that the PC on which imc STUDIO Monitor is running has
already been appropriately set up.

Firewall

The firewall used might prevent establishment of a connection between the operating software and the
measurement device. If the software is unfamiliar to the firewall, then a corresponding prompt usually appears
upon accessing the network. This happens, for example, after starting the software and upon first accessing the
device (e.g. in a device search). Some firewall programs can also block access to system and hardware-
components.

In all cases, correct operation is only possible if the connection is not blocked. The following programs are
usually affected:

Program Default path

imc STUDIO: imc.Studio.exe C:\Program Files\imc\imc STUDIO...

imc DEVICES: imcDevices.exe C:\Program Files (x86)\imc\imc DEVICES...

imc DEVICES Service: imcDevicesService.exe C:\Program Files (x86)\imc\Shared

For operation on LAN, it is sufficient to enable "Private networks". Enable this access type. You may wish to read
the operating instructions for your firewall, and / or ask your administrator / IT-department.

Windows Defender Firewall: Unblocking is performed automatically upon installation.

3.5.2  Main Windows / Components
imc STUDIO provides the framework for various components. Components appear within imc STUDIO
Monitor as main windows. A component can have one or more main windows.

The main windows appear in the Navigation pane.

On the left you see an example of the Navigation pane with the main windows Homepage, Setup, Panel
(Panel is selected).

To jump to one of the main windows, click on the corresponding button in the Navigation pane.

Navigation pane : Select this link to go to further information on operation of the Navigation pane.50
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Note Notes on the use of the simplified view

· When you use the simplified view , the Navigation pane is hidden. In this case, in order to go to the
main windows Setup and Panel, use the menu ribbon.

· The other main windows can only be reached via the Navigation pane.

· If you need it, you can show the Navigation pane , or change the view .

Tool window

Most components have their own tool window (e.g. the Panel with the tool windows: Widgets and
Data Browser). The tool windows are described in their respective sections.

Reference See also

Tool window : Select this link to go to further information on operating the tool windows and for a
description of the tool windows belonging to the imc STUDIO Monitor frame.

3.5.3  Important settings

User and User groups

imc STUDIO Monitor has the ability to administer various users which are permitted to use the program in
various ways. For details see the section "User administration".

Options

Before beginning to work with imc STUDIO Monitor, you can change essential settings, such as the folder path
where the experiments are saved.

You can change the folder path in the options (under "Project Management" > "HDD settings"):

Ribbon View

Extra > Options ( ) all

Note Reading and writing access rights are required

Please note that this setting will apply for every user of imc STUDIO Monitor. Each user must possess
reading and writing access rights for the specified folder path.
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3.5.4  Command line parameters

Opening an Experiment file

An experiment file  (e.g. MyExperiment.imcstudio) can be opened directly in the Windows Explorer by double-
clicking. This starts a new instance of imc STUDIO Monitor and opens the experiment file. The same procedure
also applies for linkages to experiment files, for example files on the Desktop.

Experiments can be started with command line parameters. To do this, create a link to an experiment file and
enter the desired parameter.

["imc STUDIO-Installation"] "Experiment-File" [/fullscreen] [/do[StartMeasurement]]
[/do[StartSequencer]]

["imc STUDIO-Installation"] Open Experiment with a specific imc STUDIO installation (optional)

In order to open an experiment file with a particular installation of imc STUDIO (imc STUDIO Monitor), extend the link
with the respective installation's name. For example:

"C:\Program Files\imc\imc STUDIO 2023\imc.Monitor.exe"
"imcDB://DB_Monitor\StandardProject\MyExperiment"

The experiment file MyExperiment.imcstudio is started in the imc STUDIO  installation (imc STUDIO
Monitor).

"Experiment file" Experiment to be loaded

Mandatory entry. Opens the experiment entered with the imc STUDIO  installation (imc STUDIO Monitor) which is set
up as the default program under MS Windows. Mostly this is the last imc STUDIO version installed, or imc STUDIO
Monitor/imc WAVE, if this component was installed along with it.

One possibility is to specify the path in absolute terms:
"C:
\Users\Public\Documents\DB_Monitor\StandardProject\MyExperiment\config\MyExperiment.imc
Studio"

Another way is to specify it in reference to the name of the database and of the project (the appropriate database
folder must be selected):

"imcDB://DB_Monitor\StandardProject\MyExperiment"

/fullscreen Fullscreen mode (optional)

In order to start an experiment in fullscreen mode, the experiment file is opened with the parameter /fullscreen.
"imcDB://DB_Monitor\StandardProject\MyExperiment" /fullscreen

After opening the experiment file, the Panel is started in fullscreen mode, if the experiment contains at least one Panel
 page.

/do[StartMeasurement] Starting the measurement (optional)

In order to start the measurement automatically upon opening an experiment file, The experiment file is opened with
the parameter /do[StartMeasurement].

"imcDB://DB_Monitor\StandardProject\MyExperiment" /do[StartMeasurement]

or
"imcDB://DB_Monitor\StandardProject\MyExperiment" /fullscreen /do[StartMeasurement]
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/do[StartSequencer] Starting the Sequencer (optional)

In order to automatically start Sequencer upon opening an experiment file, the experiment file is opened with the
parameter /do[StartSequencer].

"imcDB://DB_Monitor\StandardProject\MyExperiment" /do[StartSequencer]

or
"imcDB://DB_Monitor\StandardProject\MyExperiment" /fullscreen /do[StartSequencer]



© 2025 imc Test & Measurement GmbH imc STUDIO Monitor 2025 - Getting Started, Doc. Rev.: 8.1 - 2025-03-11
Page   32

Start Chapter   3

3.5.5  Error causes upon starting
Corrective actions for when the logbook opens with error messages directly upon starting imc STUDIO Monitor.

Message Corrective action

Error while initializing the
plug-in "imcDevices V2.x
Adapter" ...

In the product configuration, the firmware imc DEVICES is activated. However, no
appropriate firmware has been found or installed.
By default all firmware products are activated. You can take the following corrective actions:

· install the appropriate imc DEVICES-firmware. This is only necessary if you wish to use a
device belonging to this firmware group.

· deactivate the component "imc DEVICES V2.x Adapter" in the product configurator .

The loaded Project-settings
are from an older
imc STUDIO version. If you
save these settings, an
older imc STUDIO version
would not be able to read
them correctly.

With every Version/Revision, new enhancements and other changes are introduced. In
consequence of these changes, some saved projects may become no longer compatible with
older versions.

Make sure that no older version of imc STUDIO Monitor needs to access the database.

Could not connect to the
Guardian process. Some
functions (e.g. delete
measurements) will not
work.

The Guardian process is not running. Please start either the Guardian- or WatchDog-service.

For more info, see the section "Guardian"

3.6  Info / Version information

imc STUDIO Monitor is an application for imc STUDIO. imc STUDIO is used as a base and consist of multiple
components. In order to see which components are included in your package, click in the menu bar on the
symbol . Then a pop-up window appears displaying the product names and details on the components:

Version information (example)

With the buttons on the left side ①, you can change
the list's depth of detail and how it is sorted.
Additionally, you will receive all copyright notes
regarding "Open source software" ( ) ②.

With the buttons on the right side, you can start the
assistant for the product configuration  ③, start
the imc LICENSE Manager  ④ or export the
product selection ⑤.

While performing the export, you can save the contents as a file in XML format. For inquiries to our tech
support, it may be necessary to send it as an e-mail (see also section "Tech support ").
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3.7  Information and tips

3.7.1  Changing languages and installing additional languages
Following installation, imc STUDIO Monitor is available in English and, if applicable, in the language of the
operating system. Additional languages can be installed by selecting the option "Install additional languages" in
the installation variant "User-def ined ".

Note Observe operation system settings

· Please ensure that your operating system is set correctly to the display language. Some languages require
modifications to be made accordingly. In particular, the "System locale" must be set correctly to
correspond with the display language.
Otherwise, with some languages there can be problems with the characters. Languages affected include
Japanese, Chinese, Russian, ...

Changing the language

By default, the imc software will start in the same language as the Windows version installed. If this language is
not supported, then the English program version appears.

The language can be changed, irrespective of the Windows version. Use the program "imc Language Selector".
The program is found in the Start menu under the group "imc".

Note Constraints

Only the imc software's texts are converted. Components which depend on the operating system's
language setting are not affected.

Please only use one of the following two languages:

· Default: the operating system's language

· English

Any other selection may cause malfunctioning if the operating system and the imc programs use different
languages.
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Installing additional languages

If desired, all other supported languages can be installed later (no installation medium is required).

Note Which languages are be installed subsequently

In subsequent installation of languages, all languages supported are installed. There is no selection
possibilities.

Step by step

· Administrator rights are required.

· Open the  installation folder of imc STUDIO (e.g. "C:\Program Files\imc\imc STUDIO..."), e.g. with Windows
Explorer or by means of the command line.

· There, open the folder "Languages"

· Run the file "InstallLanguages.bat".

· Wait until the script stops and posts the message "Failures: 0". This indicates that the installation has
completed successfully.

Note Instruction notes

If installation was unsuccessful, the necessary user rights may be missing:

· If "InstallLanguages.bat" is called via the command line, run the command line as Administrator
(context menu: "Run as Administrator")

· If "InstallLanguages.bat" is called via the Windows Explorer, run the call as Administrator (context
menu: "Run as Administrator")

3.7.2  Recommended virus scanner settings
The presence of many channels can burden the PC if a virus protection program scans the data captured. This
may cause a jiggling display and high demands on the processor.

We strongly recommend removing imc STUDIO from the virus scan. Most virus protection programs are able to
classify individual programs as low-risk. To do this, please refer to the instructions for your virus scanner.

Low-risk Default path

Add the programs imc.Studio.exe, imc.Monitor.exe and
imc.WAVE.exe to the list of low-risk programs

C:\Program Files\imc\imc STUDIO...

Add the program imcDevices.exe to the list of low-risk
programs

C:\Program Files (x86)\imc\imc DEVICES...

Add the database path along with all subfolders to the list of
low-risk folders

C:\Users\Public\Documents\DB

Ensure that its data are not searched for viruses during reading or writing.

Reference Installation

See also the installation note: "Notes on the security software "17
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3.7.3  Enhanced installation

Installing projects

You can prepare projects which are automatically included with the installation. E.g., after the installation,
special views and experiments will already be available.

· Create a project-export-file (".imcStudioExport") for the purpose. Make sure
that the project is exported and not only the experiments (selection). Upon
exporting, you can define what the file is to contain. E.g., only the project
settings, or also the experiments.

· Save the file(s) on the installation medium in the following path:
..\Products\imc STUDIO\Projects

Produce an installation medium and run the installation as usual or install from the
hard drive.

After the first launch of imc STUDIO, projects are imported into the database.

Any existing projects
having the same name
will be overwritten.

FAQ

Question Answer

What happens if the project exists already? All project settings will be overwritten.

What happens if the project has contents which do not
exist in the project to be imported?

All content besides project settings remains intact.
E.g. experiments, measured data, metadata, ...

What happens if the project has contents which already
exist in the project to be reported?

These will be overwritten. As well, any experiments,
measured data, metadata, ... are overwritten.

What happens if there are any other projects present? These projects remain intact.

What all is imported from the project?
All project settings and any experiments, measured
data, metadata, ... the projects contain

Adding your own personal programs

On the installation medium, in the folder "Products", create an extra folder for your own product. Save your
installation file there. The Installer will now automatically detect the product and offer it for installation.

Optional: By means of an ini-file, you can cause your product to be the default selection in the Product-Selection
list.

On the installation medium (on the same level as the folder "Products"), create an additional folder named
"Configuration". There, create a file named "Setup.ini". Fill this file with the following text:

[SetupX]
SetupX1=<PRODUCT>

For <PRODUCT>, insert the name of the folder in which your installation file is located.
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3.7.4  Unattended installation - Silent installation
For unattended installation ("Silent installation"), certain parameter files (.ini) are required. Create these files by
means of a command line call.

Setup.exe /CREATEINIFILES="<TargetPatch>"

To do this, proceed as follows:

· Start the installer - e.g. "Installer_imc_STUDIO_2023_R2_2023-04-20.exe".

· The installer begins by unpacking the content of the installation medium. Select an appropriate target
folder on your hard drive: e.g under "C:\DVD\".

· As soon as the unpacking process has concluded, configuration for the installation begins. Cancel this
procedure!

· Start Windows' command prompt ("cmd", "command shell").

· Navigate to the appropriate file path and call the Setup with the following command line (in the example
here, the folder is: "S:\DVD\"):

Setup.exe /CREATEINIFILES="C:\DVD\"

The frame setup is started and may be configured as desired. When the settings are finished being made, there
is no restart, as there usually would be. Instead, at the specified target location, *.ini-files are created which
have the following structure:

Main file

DVD/Configuration/Setup.ini

Product files

DVD/Products/$Productname$/Configuration/$Filename$.ini

z.B.

DVD/Products/imc STUDIO/Configuration/imc STUDIO.setup.ini

DVD/Products/imc FAMOS/Configuration/Setup_imcFamos.ini

The ini-files contain the settings which have been made.

Subsequently, the DVD folder can be copied to a data carrier and used for the unattended installation.

Calling the unattended installation

The installation process is called with command line parameters, where "/SILENT" causes the silent setup
installation to start. The following is an example of a 64-bit system:

DVD/Setup.exe /Lang=en /DIR="C:\Program Files\imc" /SILENT

With the additional parameter "/UNINSTALL=ALL"  all previous versions are removed.

If the switch is set to "NECESSARY" only the necessary version are de-installed. When setting the switch to
"NONE", no version is removed.

In special cases a de-installation is needed, e.g. if you install the 5.2 R23 to a 5.2 R22.  The 5.2 R22 needs to be
de-installed.
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Note

Creating ini-files in a different folder

You can also create the ini-files in a different folder. In this case, merge the two folders afterward (not
recommended because prone to errors).

Please always create new ini-files each time

With any new version, it may occur that new keys are entered in the ini-files. For this reason, create new
ini-files for any new version.
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4  Monitor - First steps
imc STUDIO Monitor makes it possible for teams to monitor the live data on multiple PCs. In doing so, each
separate work station can create its own views and thus focus on particular monitoring tasks. During a running
measurement, imc STUDIO Monitor can connect with one or more measurement devices, especially for the
purposes of monitoring streaming measurement data, processing and saving them.

Configuration of the devices and start of the measurement are performed by separate device software:
imc STUDIO or imc WAVE. imc STUDIO Monitor is exclusively for the purpose of configuring the device
monitoring mechanism.

System requirements and limitations

Measurement device requirements

Configuration of multi-client monitoring of imc devices belonging to the groups:

· firmware group A via firmware imc DEVICES

Accessing the device: at most, four imc STUDIO Monitor PCs can be directly connected with one device.

Reaction to changed device configuration: When the configuration is changed in imc STUDIO, the device must be
re-selected in imc STUDIO Monitor.

Selecting a device

imc STUDIO Monitor can connect with imc devices as soon they were prepared or a measurement is running.

Selection of the measurement device is the first step.

· Open the device configuration page: "Setup".

· Go to the tab: "Devices" .

Here, all available devices are presented.

Note Connecting with the device

The same conditions for a successful search apply as for imc STUDIO. If a device is not found, there are a
variety of possible causes.

For more information on correct configuration of all network settings, see the imc STUDIO/imc WAVE
manual: Setting Up - Connect the device.

Select your device:

· Click on the Checkbox-symbol ( ) in order to select the device.

Note Firmware

In order to be able to connect with a device, the firmware version (imc DEVICES) must be installed which
matches the device.

The firmware must not only be present on the imc STUDIO computer for configuring the device, but also on
the imc STUDIO Monitor computer, in order for it to read from the device.
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Configuring channels

Next, the channels to be used are configured:

· Go to the tab, e.g: "Analog channels"  (or "Digital channels"/"Variables").

Here, all available channels/variables are presented.

Most of the parameters shown here pertain only to the device control and in imc STUDIO Monitor they appear
in gray font.

Relevant parameters appear under the tabs: "Data transfer" and "Curve properties" -> So here, configure:

· the "transfer" of data to the monitor PC,

· as well as the data storage,

· the "Circular buf fer time" for the display, and

· the range specifications for the Widgets

Transfer to PC

Transfer of the channels to imc STUDIO Monitor can be activated on a per-channel basis. Thus it is possible to
view individual channels without overburdening the network with all the channels.

For this purpose, imc STUDIO Monitor uses the channel-parameter: "Transfer to PC".

Transfer to PC
In the example, channel_001 is not transferred while channel_002 records measurement data.

Note Single value variables

Single value variables are always transferred.
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Circular buffer time

All incoming data are kept in a circular buffer memory. The volume of this buffer memory can be set for each
channel separately in the column "Circular buf fer time".

Note Circular buffer time

The circular buffer memory only applies to the display in the curve widow and does not affect storage of the
measured data!

Beginning/concluding data recording

Start data recording by means of the Start-button  ( ).

Stop data recording by means of the Stop-button  ( ).

Recording of the data runs independently of the actual measurement. If the measurement is running on the
device while recording of the data is running in imc STUDIO Monitor, the measured data are recorded. If, at a
later time, measurement (on the device) is stopped, then consequently no measured data appear in imc STUDIO
Monitor. Upon the next start of measurement, measured data immediately appear in imc STUDIO Monitor, as
long as data recording continues there. In this case, the data of the last measurement are discarded.

Configuring display of measured data

You can observe the channels in the curve window, or use the other Widgets on the Panel.

Analysis and processing of measured data

Various tools for subsequent processing and analysis of the measured data are available in conjunction with
associated licenses.

Activating data storage

By default, data storage is activated.
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5  Experiments, projects and the database
This chapter describes the interdependencies among the "database", "projects", "experiment templates" and
"experiments".

Experiment

The experiment includes a record of all settings needed for generating the measurement data as well as viewing
and evaluating them. The actual measured data are saved with the "experiment" to which they belong.

You can create a variety of experiments to accomplish a corresponding variety of measurement tasks.
imc STUDIO Monitor always works with exactly one experiment and all changes are saved to it.

Among others, the following settings are saved:

· the experiment file (filename extension: "*.imcStudio"),

· measurement files and metadata,

· various backup files and administration files

Among other things, the experiment file contains all the settings configured in the main windows and in the
Setup-Assistants.

Each experiment has a unique name which is set when it is saved .

Measurement data

By default, the measured data are saved in the Experiment folder. They belong to the experiment. You specify
the data structure in the Device-settings under "Storage" (Setup page: "Devices" > "Storage").

Project

A project is primarily a collection of various experiments. The factory settings of imc STUDIO Monitor are
configured in such a way that only one project is present and that you are aware of it to the minimum extent
possible.

All of your experiments are saved in this project ("StandardProject").

Some options and configurations are not saved along with the experiment. For instance, they might be saved
along with the project and apply to all experiments belonging to the project. In some cases, you can define what
has to be saved where. E.g. when generating variables, you can change the validity scope and, for instance, save
it not just for that experiment but for all experiments in the project.

Whatever is saved at the Project level (and thus not with the specific experiment) is correspondingly denoted at
the locations affected. A project can include:

· one or more experiments

· one or more experiment templates

· project settings (e.g. views, user administration and project-events)

After the first start of imc STUDIO, a standard project is set up in which your experiments are saved.
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Project view - working with multiple projects

When you activate "Project view", there is a project-based tree diagram in the Open- and Save-dialogs . Here,
you can create additional projects and load experiments from other projects.

Note  Creating a project resets variables

When you create a new project, the status of the experiment currently open is saved temporarily and
reloaded later after the new project has been set up. In consequence, the values of the variables are reset
to the condition they would have if the experiment were re-loaded.

In the process, the event "Experiment_Loaded" is not triggered. If you need this to happen for your
experiment, please re-load it manually. If you save your experiment with the new project ("Save As"),
something similar happens. Here, too, the variables are reset, but additionally the event
"Experiment_Loaded" is triggered.

You can activate the "Project view" in the options (under "Project Management" > "General options"):

Ribbon View

Extra > Options ( ) All

Option Description

Project view activated

To create more projects, you must activate the Project view. This option is deactivated by
default. (Information on Projects ).

There is an extended view available of some dialogs . Multiple projects can be created
and used.

Only activate the Project view if you wish to use and manage multiple
experiments in separate projects.

If this function is deactivated, some dialogs are displayed in simplified
form (e.g. "Save experiment" and "Open experiment" are missing Project
selection, for instance).

Database

The database is the data repository for imc STUDIO Monitor. Here, the projects and their associated experiments
are saved. The database does not have its own settings and configurations.

The folder path for the database can be freely selected (in the Options under: "Project Management" > "HDD
Settings").

Ribbon View

Extra > Options ( ) All

Option Description

Database folder

Here you set where the "Database" is to be saved. (Information on "Data management")

The database is not user-dependent. Note that every user who is set up in
the system has writing and reading rights for this path.
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Database conversion

If the database structure has been changed, you are subsequently notified. One way
this can happen is as a result of updating to a new version.

A conversion-dialog appears. You can convert the database or have it copied
beforehand. After the conversion, the entire database can no longer be used with
the older version.

Databases are not
downward compatible.

In the upper region, the reason why the database does not fit with the current version is noted. E.g., the
database may be too new or too old. In the list below, all databases found in the folder selected are listed. The
"Status"-bar contains information on the database.

The following approaches are available:

Approach Description

Select an existing database Select the appropriate database and click on the button "Apply".

If it is necessary to convert the database, an additional dialog appears. Here, the user is
prompted to decide whether to use the database under a new name. If you choose:

· no: the existing database is converted. It can no longer be used with the older version.

· yes (recommended): the database is copied. Enter a name for the new database. Now
you have two databases. You will have a backup copy and can continue to use the old
database with the old version.

Create a new database Click on "Create new". Enter an appropriate name for the database. It will be created in the
folder selected (parallel to any already existing databases).

Change the database's
folder

Click on the button "..." next to where the folder is indicated. Select an appropriate folder.

Here, select a folder where the database folder is to be created later. Not
the database itself. E.g. the default folder: "C:\Users\Public\Documents".
The database will be created in this folder, e.g. "DB".

Experiment Template
See: "Experiment Templates "

Creating one's own files on an experiment - in the folder "Meta"

You can create your own files on the experiment, such as metadata, imc FAMOS-sequences, info-files. To do
this, use the folder: "Meta" in the experiment path. If you save or export the experiment under a different
name, all files from the folder "Meta" come along with it.

The folder "Meta" is now ignored in all components.

· The content is not recognized as a measurement although containing measured data. This means that
there is no entry in the Data Browser.

· Interval saving does not delete the folder. When the number of intervals is limited, the folders of measured
data are deleted in succession once the specified count has been reached. The folder "Meta" is ignored,
even when the folder contains measured data.
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5.1  Dialogs: Project and Experiment
The Project Management dialogs are described below:

· with "Project view" and

· with "Experiment templates".

By default, these options are deactivated, in consequence of which not all functions are available. Options-
dependent functions are mentioned explicitly below.

The dialogs following the functions "Manage Project", "New Experiment", "Save As" and "Open" are structured
similarly. The dialog is described below on the basis of "Project Management" as an example. Not all dialogs
feature the complete scope of functionality.

Example: Manage project

The dialog is subdivided into four regions (from top to bottom):

1. Menu bar

2. List of all projects

3. List of all experiments and experiment templates in the selected project

4. Linked metadata information belonging to the selected experiment

By default, the regions 1 and 3 are displayed; the others can be activated if desired.

Region 1: Menu bar

Function Description

New

Create new project: Creates a new project in the selected database (a database must be
selected).

Create new experiment template: Creates a new experiment template  (a project must
be selected).
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Function Description

Import

Imports elements (projects, experiments and or experiment templates) from a file in the
selected entry.

The file can contain multiple elements. You can select either all or individual elements for
import. Additionally, the target name can be changed.

Be sure to first select the target correctly. You can only import a project if the database is
selected. You can only import experiments and experiment templates if a project is
selected.

You can only import projects if the Project view is activated.

Export

Exports the selected entries to a file.

Whole projects and individual/multiple experiments and experiment templates can be
exported to a file.

Manually created folders are not included with the export. The exception is
a folder in the experiment path named: "Meta ".

Delete

Deletes the selected entries.

Complete projects and individual experiments/experiment templates can be deleted. If you
select delete an experiment with saved measurement data, a prompt appears for
confirmation that you wish to delete the data.

/ Show/Hide Region 2 (list of all projects) 

/ Show/Hide Region 4 (metadata information) 

Regions 2 and 3: List of all projects / experiments / experiment templates

In these two regions, the projects/the experiment and experiment templates are listed. When you select a
project, all elements of the  project selected are displayed in the region at right.

Region 2 is only displayed if the project view is activated and the region is shown (via the menu button: ).

Region 2 only shows the experiment templates if these are activated.

Region 4: Linked metadata information

The metadata saved with the selected experiment are displayed in this region. When an experiment is saved, the
metadata can be saved automatically along with it. In the Options "Metadata" > "Experiment - Metadata" >
"Setup page", you can select which source to use for the metadata.

Only shown if the region is shown (via the menu button: ).
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5.2  Creating/Saving/Copying an experiment
Each experiment has an identifying name which is specified when it is created/saved. Each name may be used
only once per project.

When you create an experiment (ribbon menu item: "Home" or "Project" > "New"), or when you save an
experiment under a new name, you are asked for a name. In this case, enter a unique name.

If the "Project view" is activated, you can additionally select the target project.

Action Description

New Experiment When you create a new experiment, it is generated from an experiment template (see
"Experiment template ").

· If experiment templates are displayed , select an experiment template.

· If they are not displayed, the preferred experiment template  is used automatically
(at default: "StandardTemplate").

All changes since the last save are discarded if a new experiment is created.

Save experiment as When you save an experiment under a new name, a new experiment having the current
settings is created.

· Measurement data from the existing experiment are not transferred along to the new
experiment (exception: if the experiment was previously never saved; in that case a
prompt appears to ask whether to include these measured data).

· Files from the folder "Meta"  are copied and are available in the new experiment.

Copying an experiment to a
different project

You can copy experiments to a different project by means either of Drag&Drop or of the
context menu. This means that all files located in the Experiment-folder are included:
Measured data, saved measurement settings, parameter set files or user-made folders of
metadata.

5.3  Experiment templates
When you create a new experiment, it is generated from an experiment template. The new experiment contains
all properties of the selected template. In templates, all settings which are saved will be saved also in an
experiment.

After the first installation or after creating a new project, the project contains an "empty" experiment template.
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Making experiment templates visible

You can activate the "Experiment templates" in the options (under "Project Management" > "General options"):

Ribbon View

Extra > Options ( ) All

Option Description

Show experiment template

In order to be able to use experiment templates, you must previously make the experiment
templates visible. This option is deactivated by default. (Information on Experiment
templates )

An extended view of certain dialogs  is available. Experiment templates can be created
and used.

Only activate this function if you wish to create multiple similar
experiments.

If this function is deactivated, some dialogs are displayed in simplified
form (e.g. "New experiment" and "Edit project" appear without
experiment template selection).

Creating experiment templates

Ensure that experiment templates are visible. You can generate experiment templates from a variety of sources:

Source Description

From present settings The configuration currently set is used for the template. (see also "Save as template ")

From existing experiment Select an experiment from which to generate the template.

From default settings An empty template is created.

· Click on the button: "Manage Projects"

Menu ribbon View

Project > Manage Project ( ) Complete

· Select the project (if the projects are not displayed, click on the white background, in order to avoid
selecting an experiment)

· In the dialog, click on the menu item: "New" > "Add experiment template"

· Select a source

The experiment template is created from the source and and is available when creating an experiment .

Preferred experiment template

You can mark an experiment template as preferred (template context menu > "Set as preferred experiment
template"). If the experiment templates are no longer displayed, the new preferred experiment template is
automatically used when a new experiment is created.
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6  Ribbon

6.1  Project menu
The "Project" menu is available in every plug-in.

Some of the dialogs offer an extended view. By default, the dialogs are displayed without "project view" and
"experiment templates".

Project

Menu item Description

Manage
Projects

Managing projects and experiment templates

Save Project Saves the current project

Experiment

Menu item Description

New Creates a new experiment

Open Opens an existing experiment

Save Saves the current experiment

Save as

Saves the current experiment under a new name.

Additionally, the experiment is reset. The variables are assigned the respective initial value
(e.g. device variables = "0", or user-defined variables are assigned the respective initial value
specified). The event "Experiment_Loaded" is triggered.

Save as template
When you click on the button, a new template  is generated which the system then uses
automatically (keyword "Preferred experiment template "). (from the edition
"imc STUDIO Professional")

Im-/Export

Menu item Description

Import / Export In this dialog you can import and export various components.

Current Measurement

Menu item Description

Save current Data

Export current Data

In addition to the optional automatic data saving, you can also perform targeted saving of
the data currently in the PC (Current measurement) either during or subsequent to the
measurement.

See also Setup pages - Configuring device: "Storage options and directory structure" >
"Controlling Data Storage" > "Targeted Data Saving, or Saving Subsequent to
Measurement"
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Note Without imc STUDIO Project Management

In the product configuration, the component "imc STUDIO Project Management" can be deactivated. If
"imc STUDIO Project Management" is deactivated, a number of limitations apply.

Among others, there is no longer any database. The dialogs for saving and opening experiments match the
standardized "Save As"- or "Open"-dialogs. Experiments can be saved at any desired location. The saved
measurement data are stored in the designated experiment folder.

The functions of the Project Management are listed in the technical data sheet.

The description of the Project- and Experiment-dialogs n the following pages pertain to imc STUDIO with
activated Project Management.

Changes in the menu without imc STUDIO Project Management:

Project - without Project Management

Menu item Description

Save Project
Saves the current project. In this case, all "Project"-settings are saved as "Application"-
settings and apply for all experiments.

Experiment - without Project Management

Menu item Description

New experiment

Creates a new experiment. The storage location is first determined by means of "Save
experiment/Save experiment as".

The device currently selected remains selected. However, the device's configuration will be
reset.

Open experiment Opens an existing experiment. The experiment can be be saved anywhere in the file system.

Save experiment
Saves the current experiment at the storage location previously set using "Save experiment
as"; if no storage location had been determined yet, "Save experiment as" is run
automatically.

Save experiment as Saves the current experiment under an arbitrary name at any location in the file system
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7  Navigation pane and Quick access toolbar

Navigations pane

Maximized Navigation Pane
(example)

In the Navigation pane, the main windows of the installed plug-ins are displayed as
a tree diagram. To open/change the main window, click on its corresponding entry.

The Navigation pane can be opened or closed, maximized and minimized.

· To maximize/minimize the Navigation pane, click in its top bar on the
arrow symbol.

· To open/close the Navigation pane, click on the upper region of it
below the arrow.

If the Navigation pane is maximized or opened, the main windows are
additionally displayed as a tree diagram (see example shown).

Via the tree diagram, it is possible to jump to different main windows or
directly to the pages containing the main windows.

You can hide the Navigation pane.

If you hide the Navigation pane, please note that your ability to navigate between
the main windows. For this case, you should add the command: "Browse
workspace" at suitable locations, for instance in the ribbon menu ("User-def ined
buttons").

To show or hide the Navigation pane use the dialog: "Tool windows chooser ".

Quick access toolbar

The "Quick access toolbar" can be supplemented with various menu items. Which actions are available for this
purpose doesn't depend on what tab is currently displayed in the menu ribbon.

Using the context menu, you can either add or remove menu actions.

· Adding: context menu of the menu item in the menu ribbon (note: the menu ribbon may not be minimized)

· Removing: context menu of the menu item in the toolbar

You may place the toolbar either above or below the menu ribbon.

Note Saving the configuration

The configuration of the "Quick access toolbar" is saved with the respective view.

The configuration is only saved whenever the project is saved.
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8  Tool windows
Tool windows contain special elements for operating/viewing a main window. (For information on operating the
tool window: "Operation ")

Five tool windows

 
- The imc STUDIO frame's log book

 
- Four additional windows from the main window imc STUDIO Panel

One tool window belongs to the imc STUDIO frame and is always available:

· Logbook

The Logbook is always displayed and can be minimized. The other main windows' tool windows (e.g. for the
Panel) are displayed as soon as the respective main window is opened.

Note Not all tool windows are visible

By default, all necessary tool windows are displayed. All others can be displayed , if you need them.

8.1  Operation

Tool windows contain special elements for operating and editing a main window.

Tool window (example)

Each main window has its own tool window, which is described in the
documentation of the respective component. Tool windows can be moved and
deleted.

By default, the tool windows are pinned to the main window (e.g. at the bottom or
right margin).

The picture shows an opened tool window ("Details"). It is pinned and contains two
additional tabs. If you click on one of these tabs, the corresponding tool window
opens ("Dependency Tree" and "Column Finder").

Three other collapsed tool windows are seen at the right margin ("Sensors",
"Layout Repository" and "Table descriptions").

A tool window is opened when the mouse is swiped over it.

As long as a tool window is selected, or if the mouse is located over the tool
window, the tool window remains open. Otherwise, it collapses to the side.
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Showing/hiding the tool window

You can either show or hide tool windows. To do this, open the dialog: "Tool Window Chooser".

Ribbon View

View > Choose Tool Windows ( ) Complete

Extra > Choose Tool Windows ( ) Standard

Dialog: Tool windows chooser

The dialog: "Tool Window Chooser" opens.

Set a checkmark in front of the tool windows which you wish to have displayed.

Selecting "More" provides you with comprehensive layouting capabilities for the
view. You are able to place any tool window belonging to other components on the
current page. For instance, you can display the Data Browser in the window of the
Automation. Or you can show the Panel in the Setup.

Other actions

Action Description

Pinning the tool window Tool windows can be pinned. Pinned tool windows remain open even when no longer
selected.

In order to pin a tool window, click on the thumbtack-button ( ).

Freely positioning the tool
window

In order to freely position the pinned tool window, move the tool window's title bar using
drag&drop to the desired position.

Docking the tool window In order to dock the tool window, use the drag&drop technique by grabbing the tool
window's by its title bar and moving it to the desired position. A Dock-symbol will appear at
the locations which are possible.

In the center of the targeted window (main window or tool window), a
cross appears. To dock the tool window, release the mouse button with the
mouse over the desired position.

Dock at the top/bottom margin

Dock at the left/right margin

Insert as a tab in a different window (see example)
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8.2  Logbook
In the tool window "Logbook", messages of the categories: "Fatal" ( ), "Error" ( ), "Warning" ( ) and
"Information" ( ) are entered. The logbook entries indicate what problems and errors exist and provide hints
on where to find them and how to remedy them. Some actions performed are documented.

E.g., a note is entered in the logbook for every command performed:

· performed successfully ("Information") or

· otherwise "Error" or "Warning"

By default, the Logbook is opened when an entry any of the categories "Fatal", "Error" or "Warning" occurs. By
default "Information" category notes are entered into the logbook without any further effect.

Example of  logbook entries

Each logbook entry consists of:

Parameter Description

Symbol for the category Fatal ( ), Error ( ), Warning ( ) and Information ( )

Time Time the logbook entry occurred

Code Logbook entry's error code

Message Exact description of the logbook entry

Sender The origin of the logbook entry

After a new imc STUDIO Monitor start, the logbook is empty. The logbook itself only displays messages which
occurred since the last start. Older messages can be opened with the "Logbook-Viewer".
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9  Views
The program's GUI is adaptable, so that for example the windows and columns can be positioned and displayed
according to the user's desires. The layout of the GUI is saved in so-called "Views". It is possible to create
separate views for various requirements.

The following settings are saved along with a view:

Region  Description

Window arrangement The imc STUDIO Monitor window's and the tool window's position and size

Menus Layout of the menu ribbon and the Quick access toolbar

Layout · The last main window opened

· The tool window's layout (e.g. what metadata columns are displayed in the
Data Browser)

· The arrangement and configuration of the Setup pages (e.g. arrangement of columns,
such as metadata columns)

Note Views and projects

The relationship between saving the view and saving the project

The views are saved with their respective project. When a view is saved, it is necessary for the project to be
saved. The system will notify the user accordingly.

Conversely, when a project is saved, the view is not automatically saved. Views are only saved whenever
the action "Save View (as)" is intentionally selected. In order to avoid every little change to a view being
saved whenever the project settings are saved, the views are ignored when specifically the project is saved.

Settings which apply globally to all views are saved with the Project

Please note that only the positions of individual elements is saved along with the views. The existence and
configuration, for instance, of the Setup-columns (tables- and column descriptions) is saved along with the
respective project. (see also "What is saved where?")

Since the project is always saved whenever the view is saved, the current configuration of the columns is
also included when saving.

Overview of settings saved with the project, which affect the views

· Setup table descriptions and column descriptions (these include, for example, additional columns, such as
metadata-columns, parameter set columns, ...) (tool window: Table Descriptions)

· saved Setup  complete layouts (tool window: Layout Repository)

Note Detecting changes to a view

If any major changes (columns added, menu changed, etc.) are made, the system explicitly recognizes this
as a change to the view. When you exit the project by switching to a different project or by closing
imc STUDIO Monitor, you are prompted to select whether to save the changes.

Minor changes, such as changed size of tool windows, are ignored.
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Saving views

In order to save the current view, select the menu item "Save View (as)":

Ribbon View

View > Save View / Save View as (  / ) Complete

Extra > Save View / Save View as (  / ) Standard

All settings belonging to the current view are saved. These include the items named above.

Note The views are saved with the project

The views are saved with their respective project. When a view is saved, it is necessary for the project to be
saved. The system will notify the user accordingly.

Loading views

In order to load a saved view, select the menu item "View" in the drop-down list of the respective view. Here, all
views available to the project are displayed.

After the selection the view is loaded.

The record of an experiment includes the view in which the experiment was saved. When the experiment is
loaded, the view also loads automatically.

Deleting views

To delete a saved view, select the menu item "Delete View".

Ribbon View

View > Delete View ( ) Complete

Extra > Delete View ( ) Standard

In the dialog which then opens, select the view to delete from the drop-down list. Confirm your selection by
clicking on "Save project".

Restoring views

Views are not write-protected. They can be restored to their original state. The factory settings come with a
copy of all views created as part of the program installation.

To restore a view from the factory settings, select the menu item "Restore".

Ribbon View

View > Restore ( ) Complete

Extra > Restore ( ) Standard

In the dialog which then opens, select the desired views. They are imported from the factory settings. Conform
your selection by clicking on "OK".
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9.1  Exporting/importing views
When you export the view settings, a variety of project settings are stored in the export file.

Settings Description

Saved views · table descriptions and column descriptions (these include, for example, additional
columns, such as "metadata columns", "parameter set columns", ...)
(tool window: "Table Descriptions")

· saved complete layouts (tool window: "Layout Repository")

Sensors · user-defined characteristic curves/sensors (tool window: "Sensors")

Export of views, metadata columns, sensors, ...

By means of the menu item "Import/Export", you can export the view settings:

Ribbon View

Project > Import/Export ( ) Complete

Extra > Import/Export ( ) Standard

· Choose option "Export" and then the list item "Export views, meta data columns, sensors, ..."

· Choose an appropriate file name and path for the view settings file

Note Save the view beforehand

Save the view beforehand if you have made any changes (see "Views ").

Import of views, metadata columns, ...

Using the menu item "Import/Export", you can import the view settings to the current project:

Ribbon View

Project > Import/Export ( ) Complete

Extra > Import/Export ( ) Standard

· Choose option "Import" and then the list item "Import views, meta data columns, ..."

· In the file selection dialog, selected the saved view settings file
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Thereafter you will see a dialog allowing you to import either all or individual view settings.

Entries having colored shading already exist in the current project. In this example, the complete layout "New
Page" is not yet present there.

Checkbox Description

Selected (left) Check this box if you wish to import the element.

Overwrite? (right) Check this box if the element in the project is to be overwritten without any confirmation
prompt. If the box is not check-marked, a prompt appears to inquire the name for the
element to be imported. (Unless "Replace all items selected" is check-marked.)

Replace all items selected Corresponds to "Overwrite?" for all entries: Check this box if you want to replace all
elements without any confirmation prompt.

You can select the following elements:

Element Description

Layouts All these elements belong to the Setup pages. Saved pages and saved designs, which can be
displayed on the pages. For more information on the complete layouts, see the chapter:
"Table Description and Complete Layout".

Views Her you find the imc STUDIO-views. The views  apply for all components of imc STUDIO.

Note New functions can be overwritten

Be aware that when making replacements, new functions may be lost if you import old views/columns.
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Importing defined additional columns

An additional prompt appears if

· discrepancies between existing Setup columns were detected or

· the file contains additional columns.

Select which columns to import and/or any to replace.

If the column already exists, a checkbox appears under "Overwrite?". If the box is not check-marked, the column
is automatically renamed. You can edit the name afterward. For more information, see the chapter: "Creating
and conf iguring additional columns".
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Phone: (Germany): +49 30 467090-0

E-Mail: info@imc-tm.de

Internet: https://www.imc-tm.com

Tech support

If you have problems or questions, please contact our tech support:

Phone: (Germany): +49 30 467090-26

E-Mail: hotline@imc-tm.de

Internet: https://www.imc-tm.com/service-training/

Service and maintenance

Our service team is at your disposal for service and maintenance inquiries:

Phone: (Germany): +49 30 629396-333

E-Mail: service@imc-tm.de

Internet: https://www.imc-tm.com/service

imc ACADEMY - Training center

The safe handling of measurement devices requires a good knowledge of the system. At our training center,
experienced specialists are here to share their knowledge.

E-Mail: schulung@imc-tm.de

Internet: https://www.imc-tm.com/service-training/imc-academy

International partners

You will find the contact person responsible for you in our overview list of imc partners:

Internet: https://www.imc-tm.com/imc-worldwide/

imc @ Social Media

https://www.facebook.com/imcTestMeasurement

https://www.youtube.com/c/imcTestMeasurementGmbH
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